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1. About Recoveryfix for OST to PST 

Welcome to the user guide of Recoveryfix for OST to PST email migration software, which is one of the 
most proficient and reliable utility to recover severely corrupted OST files along with its crucial email items 
like tasks, journals, contacts, appointments, sent items, or calendar, etc. The software is critically 
developed to ensure the flawless recovery of OST files as it embeds various smart features, which overall 
enhances the OST file recovery experience. 

 

1.1 Using this Manual 

This product guide is specifically designed to guide various categories of users, which includes System 
Administrators, home users, or technical experts. The manual describes the complete functioning of the 
Recoveryfix for OST to PST software, including the brief description of software interface.  

Despite this, if you are using the software for the first time, then it is recommended to follow the entire 
product guide consistently. However, if you are already familiarized with software interface, then you can 
directly refer to the table of contents for getting brief overview of particular topic pertaining to the software 
functionalities. The table of contents is arranged chronologically to ease the utilization of this manual. It 
comprises of following sections as mentioned in the bullet points:    

 Introduction 

 Getting Started 

 Software Interface 

 Using Recoveryfix for OST to PST 

 Saving Options 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notice 

Certain acronyms have been used throughout this manual. For clear understanding of the contents of this 
user manual, please go through the list mentioned below, before reading the manual. 

1.1.1 List of Abbreviations  

 OST or .OST: Offline Storage Table 

 PST or .PST: Personal Storage Table  

 EML or .EML: Electronic Mail (Outlook Express) 
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 MSG or .MSG: Message Files (MS Outlook) 

 DBX or .DBX: Email Folder (Outlook Express) 

 QFSCI: Quick File System Component Identification 

 RTF or .RTF: Rich Text Format 

 HTML: HyperText Markup Language  

 MS: Microsoft 

 RAM: Random Access Memory 

 MB: Mega-Byte 

 GB: Giga-Byte 

 

1.2 Recoveryfix for OST to PST 

Recoveryfix for OST to PST is competent in recovering various kinds of OST file errors, including the case 
of accidental deletion of OST mailboxes. You can blindly trust this software to resolve major Outlook OST 
corruption issues that are further mentioned in the following key points: 

 “Internal Error Code=0000000E” 

 Exchange Server crashes 

 Registry errors  

 Virus infections 

 Hard drive errors 

 Abrupt system shutdown 

 Outlook crashes 

Recoveryfix for OST to PST is integrated with advanced saving options that gives you varied range of 
options to save recovered OST files. Furthermore, the software is programmed with intelligent QFSCI 
algorithms, which helps in providing the speedy recovery of all the OST data files, such as Notes, 
scheduled tasks, Drafts, appointments, Calendar entries, Journal, Deleted Items folders, etc. 

 

1.3 Spectacular Features 

Recoveryfix for OST to PST is hard-coded with unique user-friendly features that are essential for trouble-
free recovery of Outlook OST files. You can acknowledge the outstanding features of the software 
interface in the following highlighted points: 
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 Executes authentic conversion of corrupt OST files into the Outlook PST file. 

 Proficiently recovers essential email items of OST, which includes journals, drafts, contacts, 
emails, calendars, appointments, sent items, or trash items, etc. 

 Configured with two efficient scan modes, i.e. Standard and Advanced mode, which facilitates the 
recovery of brutally corrupted OST file in any case. 

 Offers multiple saving options, which enables easy saving of recovered OST files in PST, MSG, 
and EML file formats. 

 Genuinely supports OST file of MS Exchange 5.0, 5.5, 2000, 2003, 2007, 2010 and 2013 versions. 

 Enhanced with rich graphical user interface, which gives you a simplistic view of software interface. 

 Provision to repair and convert password-protected, encrypted, or compressed OST files. 

 Equipped with additional options to save recovered OST mailboxes in HTML, TXT, or RTF format. 

 Creates Outlook PST files that are compatible to MS Outlook 97, 98, 2000, 2003, 2007, 2010 and 
2013 editions. 

 Loaded with Live Update feature that facilitates the automatic upgradation of software version. 

 

1.4 Who Should Use this Software? 

The Recoveryfix for OST to PST is the fair deal for those users who urgently require the restoration of all 
corrupt OST data files. The software is effective for both, technical as well as non-technical user because 
it provides effortless email migration process and allows any user to save the recovered OST data files in 
desired formats like EML, PST, or MSG. 
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2. Getting Started 

As you have ascertained the core functionality of the Recoveryfix for OST to PST software, now it is best 
time to analyze the technicalities associated with it. You can initiate the analysis part by simply 
downloading and installing the Recoveryfix for OST to PST software. However, it is strictly advised that 
you should scan the minimum software and hardware requirements before installing the software on your 
computer.   

 

2.1 Installation Pre-requisites 

The pre-requisites for installing and running Recoveryfix for OST to PST can be broadly classified into two 
major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 64 MB RAM (128 MB Recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

 You should have at-least 10 MB of free disk space if you want to repair and save a 
10 MB .PST file. 

2.1.2 Software Requirements: 

The software requirements for installing the Recoveryfix for OST to PST software can further be grouped 
into two categories – Operating system requirements and applications version requirements. The 
requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems (32 and 64 Bit Versions): 

 Windows 8/ Windows 8.1 

 Windows 7 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 
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2.1.2.2 Supported Application Platforms 

 Supported MS Outlook versions: Microsoft Outlook 97, 98, 2000, 2002, 2003, 2007, 2010 and 
2013 (both 32 and 64 bits) 

 Supported MS Exchange Server versions: MS Exchange 5.0, 5.5, 2000, 2003, 2007, 2010 and 
2013 

 Supported Outlook Express versions: MS Outlook Express version 5.0 and above 

 

2.2 Downloading Recoveryfix for OST to PST for the First Time 

You are eligible to download and install the Recoveryfix for OST to PST software if you have thoroughly 
inspected the software and hardware system requirements. Despite this, you can purchase the licensed 
version of Recoveryfix for OST to PST by engaging with any one of our authorized resellers– Element5, 
and Avangate. However, if you are interested in trying the evaluation version, then you can download the 
free copy of Recoveryfix for OST to PST from the following link: 

http://www.osttopstconverter.recoveryfix.com/download.html 

 Evaluation version of Recoveryfix for OST to PST tool permits you to recover data 
from an infected or damaged OST file, but restricts you from saving the recovered 
OST data files. 

2.3 Installing Recoveryfix for OST to PST 

Install the Recoveryfix for OST to PST software as soon as the software is downloaded on your computer 
machine. After you have downloaded the installer file, execute the following steps to install the software: 

1. Double-click the Recoveryfix for OST to PST installer file.  

2. Follow the on-screen instructions. When the installation process completes “Completing the 
Recoveryfix for OST to PST Setup Wizard” message appears on the software installation 
screen.  

3. Click the Finish button to complete the software installation, and then launch the software. 

 

2.4 Run Recoveryfix for OST to PST  

To run Recoveryfix for OST to PST: 

Click the Start  All Programs  Recoveryfix for OST to PST  Recoveryfix for OST to PST 

OR 

For Windows 8/8.1 Users 

http://www.osttopstconverter.recoveryfix.com/download.html
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Press the Windows key  Type Recoveryfix for OST to PST  Select Recoveryfix for OST to PST 

Alternatively, you can also launch the Recoveryfix for OST to PST software by double-clicking the shortcut 
icon available on the desktop and Quick Launch icon. 

 

2.5 Uninstalling Recoveryfix for OST to PST 

You may need to uninstall or re-install Recoveryfix for OST to PST. In order to do this, you can initiate the 
uninstallation process of Recoveryfix for OST to PST in two different ways: 

Uninstall from the Windows Start menu 

To uninstall Recoveryfix for OST to PST from Windows Start menu: 

1. Click Start  All Programs Recoveryfix for OST to PST  Uninstall Recoveryfix for OST to 
PST 

2. A warning message will be displayed 

3. Click Yes to uninstall Recoveryfix for OST to PST 

OR 

For Windows 8/8.1 Users 

1. Press the Windows key  Type Recoveryfix for OST to PST  Select Uninstall Recoveryfix 
for OST to PST 

2. A warning message will be displayed 

3. Click Yes to uninstall Recoveryfix for OST to PST 

 Before proceeding to uninstall Recoveryfix for OST to PST, you must ensure that the 
software is not running.  

 

Uninstall from Control Panel 

You can alternatively uninstall Recoveryfix for OST to PST from the Control Panel by performing the 
following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon 

2. Select Recoveryfix for OST to PST and click Remove 

3. A warning message will be displayed 

4. Click Yes to uninstall Recoveryfix for OST to PST 

OR 
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For Windows 8/8.1 Users 

1. Press the Windows key  Type Control Panel  Select Control Panel 

2. Select Recoveryfix for OST to PST, and then click Remove 

3. A warning message will be displayed 

4. Click Yes to uninstall Recoveryfix for OST to PST 
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3. Software Interface 

Let us explore the rich graphical interface of Recoveryfix for OST to PST along with its intelligent 
functionalities and features.  

3.1 Menu-bar 

The menu-bar comprises of two distinct menus that spreads out into several menu items. These easy-to-
use menu items assist users in repairing and converting OST data files. The menus are: 

 File Menu  

 Help Menu 

 

3.1.1 File Menu 

The File menu comprises of three menu items. 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Next Click this button to move forward 

Back Click this button to move backward 

Exit Closes the Recoveryfix for OST to PST application 

 

3.1.2 Help Menu 

The Help menu comprises of three menu items. 

 

Figure 3.2: Help Menu 
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Menu items in the Help menu: 

Field Name Field Description 

About Displays version and support related information about the 
software 

Help Displays User’s Help Manual of Recoveryfix for OST to PST 

Software Homepage Navigates to the Recoveryfix software’s Website 

3.2 Tool-bar 

You can access tool-bar icons that are placed just beneath the menu-bar of Recoveryfix for OST to PST 
interface. In order to familiarize with tool-bar icons and its functionalities, refer the below mentioned table: 

 

Button Function Button Description 

 

Moves one step forward 
Click this button to proceed 

with the next step 

 

 
Moves one step backward 

Click this button to step back 
the recovery process 

 

 Terminates the process 
Click this button to terminate 
the active recovery process 

 

 

Displays user manual of Recovery 
for OST to PST 

 

Click this button to view user 
help manual 
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Navigates to the product website 
Click this button to reach 

directly to the Recoveryfix buy 
page 

 

3.3 Left Pane 

Left Pane of Recoveryfix for OST to PST provides you the rich and interactive way to identify, select, and 
preview recovered OST data files. Using this hierarchical tree-like structure, you can easily preview and 
select the desired email items that are to be saved. 

 

  

Figure 3.3: Left Pane 
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3.4 Right Pane 

Right Pane of Recoveryfix for OST to PST details out the email messages that belongs to the selected 
mailboxes of the left pane. It also contains the preview pane that displays the inner content of selected 
email items as shown in the screenshot given below: 

 

 

Figure 3.4: Right Pane 
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4. Using Recoveryfix for OST to PST 

Recoveryfix for OST to PST is the intelligent and compact email migration tool, which executes the 
flawless conversion of corrupt OST files into the Outlook PST. The software has the competency to repair 
various kinds of OST corruption that are emerged because of brutal Exchange Jet engine errors, hard 
drive failure, dirty shutdown state, or Outlook crash, etc. You will get to acknowledge the competencies of 
Recoveryfix for OST to PST after operating and utilizing various functionalities of this software. 

 

4.1 Standard Mode  

Recoveryfix for OST to PST is configured with result-oriented algorithms that process corrupt OST files 
with the help of two integrated scan modes, i.e. Standard and Advanced mode. In the following steps, you 
will get to experience the efficiency of these scan modes along with the smooth OST recovery process. 

1. Click Start All Programs  Recoveryfix for OST to PST  Recoveryfix for OST to PST to launch 
the software. The Recoveryfix for OST to PST window is displayed. 

 

 

Figure 4.1: Welcome Screen 

2. Click the Browse  button to upload corrupt OST files. Now, select the desired OST files 
from the Open dialog box, and then click Open to upload the file in the software interface.   
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Figure 4.2: Open dialog box 

3. After the OST file selection, select the Standard button, and then click Next to proceed. 

 

Figure 4.3: Standard mode 

 

4. By clicking the Next button, the software starts scanning the corrupt OST data files and then displays 
all email items in the hierarchical tree-like structure. 

5. Select the required email items from the left pane and click the Next button for proceeding with saving 
formalities. 
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Figure 4.4: Preview Window 

 

 

6. In the Saving Options window, select the desired saving option from Save In Outlook and Save In 
Outlook Express options, and then specify the location to save PST files by clicking the Browse 
button. 

7. The Saving Options window has several other options, such as Split Option, Remove 
“IPM_SUBTREE” from hierarchy, and Attach Prefix To Store Name.  

8. Configure all the required options, and then click OK to complete the saving process.  
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Figure 4.5: Saving Options Window 

 

 

 

4.2 Advanced Mode  

If you are dealing with brutally corrupted or permanently deleted OST files, then the Advanced mode is the 

most effective scan technology. This mode can also be used when the Standard mode is unable to retrieve 

the corrupt OST data items. Recoveryfix for OST to PST offers you such smart dual alternatives to assure 

the 100% recovery of all lost and corrupt emails. To begin with process: 

1. Click Start All Programs  Recoveryfix for OST to PST  Recoveryfix for OST to PST to launch 
the software. The Recoveryfix for OST to PST window is displayed. 
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Figure 4.6: Welcome Screen 

2. Add the corrupt OST file in the software interface, and click the Browse  button, which 
instantly displays the Open dialog box. Select OST file that need to be processed and then click Open 
to continue.  

 

Figure 4.7: OST File Selection 

3. Select the Advanced scan mode and click the Next button to initialize the recursive scan operation. 
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Figure 4.8: Advanced Mode 

4. Once the scanning of corrupt OST data items gets finished, the software enlists all email items in the 
hierarchical structure. Select the desired email items from the left pane and click Next to proceed. 

  

Figure 4.9: Preview Window 
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5. In the Saving Options window, select the desired saving option to save the recovered OST email 
items in Outlook PST file format.  

6. After configuring all the necessary options like- Saving Path, Split Option in the Saving Options 
window, click OK to finalize the process. 

 

Figure 4.10 Saving Options Window 
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5. Saving Options 

Recoveryfix for OST to PST is integrated with multiple saving options and additional facilities to fine-tune 
the output results. Now, you can view the recovered OST files in either MS Outlook or Outlook Express 
email application. Apart from this, the software supports almost all editions of MS Outlook and Outlook 
Express. Following steps will help you in understanding the different categories of saving options provided 
by the Recoveryfix for OST to PST software.  

 

5.1 Save in Outlook  

Once you have efficiently retrieved OST email items by utilizing the processing power of Recoveryfix for 
OST to PST, saving OST recovered files is the final step in the OST recovery process.  

1. When the Saving Options window is displayed, select Save In Outlook button to save file supportable 
in any of the MS Outlook version. 

2. Select the Save In Outlook option, and specify option between Save in PST or Save in MSG to save 
files in either Outlook PST mailbox or individual email items, respectively. 

3. To assign the saving location, click the Browse button and select the desired storage location on your 
computer’s hard disk. 

4. The software also offers you Split Option, using which you can split large-sized PST files into smaller 
chunks. To know more about various split option, you can refer to the below mentioned table. 

5. Select Remove “IPM_SUBTREE” from hierarchy in Outlook and Attach Prefix to Store Name 
option as per the requirement.  

6. After the appropriate configuration of all options, click the OK button to initialize actual saving process. 
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Figure 5.1: Save In Outlook 

 

Option Description 

Save In Outlook Select this option to save email items in MS 
Outlook 

Save in PST Select this option to save recovered OST files in 
PST format 

Save in MSG Select this option to save output files in individual 
email messages or MSG file 

Saving Path Click the Browse button to assign the storage 
location of recovered data files 
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Split Option Description 

Do not Split Select this option to create single PST file 

Split file after 1 GB Select this option to divide the PST file into equal 1 
GB size PST files 

Split file after 1.5 GB Select this option to split the PST file into equal 1.5 
GB size PST files 

Split file after 2 GB Select this option to fragment the PST file into 
equal 2 GB size PST files 

Split file after 2.5 GB Select this option to fragment the PST file into 
equal 2.5 GB size PST files 

Split file after 3 GB Select this option to fragment the PST file into 
equal 3 GB size PST files 

Split file after 3.5 GB Select this option to fragment the PST file into 
equal 3.5 GB size PST files 

 

  

5.2 Save in Outlook Express  

You can initiate the saving process by taking the second approach for saving recovered OST files. The 
Recoveryfix for OST to PST software provides you an additional option to save files in the latest supported 
Outlook Express edition. (Refer to the Mentioned Table for Quick Overview) 

1. Select the Save In Outlook Express option to save OST files on the latest versions of Outlook 
Express mailboxes. 

2. Once you have clicked the Save In Outlook Express option, then Save in OE Store and Save in 
EML options are enabled. Select either Save in OE Store or Save in EML option to save files in OE 
mailboxes or individual email messages, respectively. 

3. Enable the Remove “IPM_SUBTREE” from hierarchy in Outlook Express option to remove 
IPM_SUBTREE from the hierarchy of selected folders. 

4. Configure the saving location along with some other options, and then click the OK button to 
complete the saving process.  
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Figure 5.2: Save In Outlook Express 

Option Description 

Save in Outlook Express Select this option to save recovered files on 
latest versions of Outlook Express 

Save in OE Store Select this option to save OST files in Outlook 
Express mailbox 

Save in EML Select this option to save recovered files in 
individual email messages of Outlook Express 

Saving Path Browse and specify the saving location 

Hierarchy start from IPM_SUBTREE  
Outlook Express 

Select this option to enlist the selected folders 
of IPM_SUBTREE in hierarchy 
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6. Full Version 

The Recoveryfix for OST to PST software is available in two distinct copies, which are free evaluation 
version and full version. The free version is handy to all those users who want to assess the functionalities 
of the software before actually purchasing it. 

 

6.1 Requirement of Full Version 

The evaluation version of Recoveryfix for OST to PST allows you to run its embedded features. Using the 
trial version, you can trigger the OST recovery process without any hassles. In addition, the trial version 
provides the preview of all the recovered files, which allows you to authenticate the integrity of emails. 

The trial version effectively recovers OST files along with several email items like journals, contacts, sent 
items, drafts, appointments, emails, trash items, or journals, etc. However, it is not programmed to save 
the recovered OST data files. For this reason, you are required to purchase the full version of Recoveryfix 
for OST to PST. 

 

6.2 Purchasing Full Version 

You can purchase the full version of Recoveryfix for OST to PST from any one of our authorized resellers 
– Element5, and Avangate. 

Once your purchasing transaction of software’s full version with our reseller is completed, then instantly 
our sales team will send you an email comprising of URL for download and activation details of the 
software.  

 

 

 

 

 

 

 



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d         

7. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to Recoveryfix for OST to PST usage. The software comes with an embedded help manual that can be 
opened by clicking Help in the tool-bar. You can also press the F1 key of your computer’s keyboard to 
open the embedded help file of Recoveryfix for OST to PST. 

You can access the online help for Recoveryfix for OST to PST at  

Web Support:  

Online Support:  

You can also get the help of our experts online by visiting our support section. You can communicate 
directly to our experts online. 

http://www.recoveryfix.com/contact-us.html 

Telephone Support:  

Software Helpline:  

+91-9818725861 

Email Support:  

For Sales: sales@recoveryfix.com  

For Support: support@recoveryfix.com  

 

 

 

 

 

 

 

 

http://www.recoveryfix.com/contact-us.html
mailto:sales@recoveryfix.com
mailto:support@recoveryfix.com
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8. Troubleshooting 

This section deals with your generic and specific queries pertaining to Recoveryfix for OST to PST 
operations. 

8.1 Common Issues 

Why does Recoveryfix for OST to PST have limitations in the evaluation copy? 

Although you can run and experience the functionalities of the Recoveryfix for OST to PST by operating 
the evaluation version at free of cost, but there are certain features that are not available in the evaluation 
version, which is nothing but various saving options. The evaluation copies are purely developed for you to 
perform the trial runs of the software before investing any money. 

8.2 Frequently Asked Questions 

 

How to Buy Recoveryfix for OST to PST? 

You can buy Recoveryfix for OST to PST online at http://www.osttopstconverter.recoveryfix.com/buy-
online.html 

I have lost my full version for Recoveryfix for OST to PST. Can you help me? 

Please email us at sales@recoveryfix.com. Please include your name, address, email address, and 
order confirmation number (if you have it). We will be happy to help you. 

How to confirm that the software version of Recoveryfix for OST to PST is the latest one? 

The Recoveryfix for OST to PST software has the dynamic facility to receive latest updates from the 
software’s server automatically because of the configured Live Update feature. However, if you want to 
check the software’s version, then click Help in the menu-bar and then select the About option from the 
drop-down list.  
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9. Legal Notices 

This section comprises the legal specification about Recoveryfix for OST to PST and the company 
LEPIDE SOFTWARE PRIVATE LIMITED 

9.1 Copyright 

LEPIDE SOFTWARE PRIVATE LIMITED, Lepide Software accompanied user manual and documentation 
are copyright of LEPIDE SOFTWARE PRIVATE LIMITED, with all rights reserved. Under the copyright 
laws, this user manual cannot be reproduced in any form without the prior written permission of LEPIDE 
SOFTWARE PRIVATE LIMITED. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

© LEPIDE SOFTWARE PRIVATE LIMITED. All rights reserved 

9.2 Trademark 

Recoveryfix ® is a copyright work of LEPIDE SOFTWARE PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, Windows 7, Windows 8, MS 
Outlook, Outlook Express, MS-DOS and Open Office are registered trademarks of Microsoft Corporation 
and Sun Microsystems, Inc. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

9.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. LEPIDE SOFTWARE PRIVATE LIMITED provides no warranty with regard to 
this manual or any other information contained herein and here by expressly disclaims any implied 
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing 
LEPIDE SOFTWARE PRIVATE LIMITED assumes no liability for any damages incurred directly or 
indirectly from any technical or typographical errors or omissions contained herein or for discrepancies 
between the product and the manual. In no event shall LEPIDE SOFTWARE PRIVATE LIMITED, be liable 
for any incidental, consequential special, or exemplary damages, whether based on tort, contract or 
otherwise, arising out of or in connection with this manual or any other information contained herein or the 
use there of. 

9.4 License Agreement 

Recoveryfix for OST to PST Copyright © by LEPIDE SOFTWARE PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by LEPIDE SOFTWARE PRIVATE 
LIMITED. The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Recoveryfix for OST to PST. For purposes of this License, if you have a valid license, you have 
the right to use a single Licensed Copy of Recoveryfix. 
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Scope of License 

Each Licensed Copy of Recoveryfix for OST to PST may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Recoveryfix, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by LEPIDE SOFTWARE PRIVATE LIMITED. You may not rent, lease, modify, 
translate, reverse engineer, decompile, disassemble, or create derivative works based on, Recoveryfix, 
nor permit anyone else to do so. You may not make access to Recoveryfix available to others in 
connection with a service bureau, application service provider, or similar business, nor permit anyone else 
to do so. 

Warranty Disclaimers and Liability Limitations 

Recoveryfix for OST to PST, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Recoveryfix, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Recoveryfix covered by this License. This disclaimer of warranty constitutes an essential part of 
this License. In addition, in no event does LEPIDE SOFTWARE PRIVATE LIMITED authorize you or 
anyone else to use Recoveryfix for OST to PST in applications or systems where Recoveryfix for OST to 
PST failure to perform can reasonably be expected to result in a significant physical injury, or in loss of life. 
Any such use is entirely at your own risk, and you agree to hold LEPIDE SOFTWARE PRIVATE LIMITED 
harmless from any and all claims or losses relating to such unauthorized use.  

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by LEPIDE SOFTWARE PRIVATE LIMITED herein. 

Any waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any violation of this License by you shall not 
constitute, nor contribute to, a waiver by LEPIDE SOFTWARE PRIVATE LIMITED of any other or future 
violation of the same provision, or any other provision, of this License. 

 


